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Installation and User Guide

Table of Contents
Table of Contents
2
1.
About LCIT 5.0
3
2.
Installation
4
2.1.
Troubleshooting
4
3.
Running LCIT
4
3.1.
Troubleshooting
4
3.2.
Resetting to Defaults
5
4.
Discovery Wizard
5
4.1.
Auto Discover
5
4.2.
Using Non-Default IP Ranges
6
4.3.
Pinging Inserted IP Ranges
7
4.4.
Collecting Node Information
8
4.5.
Collecting Node Information Again
9
4.6.
Troubleshooting
9
5.
Grouping Configuration
10
5.1.
Grouping
10
6.
Management
12
6.1.
Node Tree
13
6.2.
Node Tree Options Menu
13
6.3.
Detailed Tree View
14
6.4.
Looking at Node Information
15
6.5.
Looking at BladeCenter Information
16
6.6.
Looking at Storage Node Information
17
6.7.
Node Message Box
18
6.8.
Help Screen
18
6.9.
Restarting LCIT
18
7.
Logging Cluster Information
19
7.1.
Summary Log
20
7.2.
Message Box Log
21
7.3.
Global Log
22
7.4.
Details Log
23
7.5.
Node and BMC Logs
24
7.6.
Difference Log Viewer and Diff Logs
25
8.
LCIT Options
26
8.1.
Configurable Preferences
26
8.2.
Grouping
27
8.3.
Discovery Wizard and Auto Discovery
27
9.
Troubleshooting
28
9.1.
Booting Problems
28
9.2.
Discovery/First Run Problems
28
9.3.
Cluster Manager Problems
30


1. About LCIT 5.0
LCIT (Linux Cluster Installation Tool) version 5.0 is a complete overhaul of the previous LCIT.  It is primarily to be used as a service and support tool and provides many methods for gathering cluster information and troubleshooting a cluster.

2. Installation 

LCIT 5.0 is a bootable CD, so using it is simple.
1. Place CD into the management node (e.g. x346, x336, e326m)
2. Boot management node from CD ROM
3. Wait for LCIT to load, this may take some time as the file system is compressed on the CD ROM.  

4. LCIT will automatically login and boot into an X Windows session.  From there, the tool can be used normally (see sections 3 and 4)
2.1. Troubleshooting

1. If the CD fails to boot, you may need to check the system BIOS to make sure that the CD ROM is set before the Hard Drive in the boot order.  
2. If some ‘Failed’ messages appear during the CD boot process, this does not necessarily mean LCIT will fail to load.
3. Running LCIT
Once LCIT has booted into X Windows, it is ready to be run.  LCIT can be started one of three ways:
1. Left click on the desktop and select “LCIT” from the menu
2. Click on the “Tools” button in the top panel and select “LCIT” from the resulting menu.

3.
Optionally, the tool can be run in auto-discover mode by selecting “LCIT Auto” from the “Tools” menu or by typing the following in a terminal:

# lcit5
This mode will start the tool and force an auto-discover if no previous configuration files exist.  This is optional and included for ease of use.  

3.1. Troubleshooting 

If the LCIT program does not appear at all after clicking on a LCIT button, 
# killall python

This will terminate any existing instances of LCIT and then allow LCIT to be restarted.  
3.2. Resetting to Defaults

If needed, all the log files and IP tables can be reset to default by issuing the following command:

# cd /opt/lcit

# ./reset_defaults

4. Discovery Wizard
When LCIT first starts, the Discovery Wizard will load.:
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4.1. Auto Discover
Typically, the cluster can be auto discovered using only defaults.  To do this, click “Actions” then “Auto-Discover.”
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After Auto-Discovery is complete, the Grouping Configuration window will be displayed.  This is discussed in a later section.

4.2. Using Non-Default IP Ranges

If the cluster is using non-default IP ranges, a range to scan can be specified.  The “Range” button on the left-hand side will bring up the “Add Custom IP/Range” window.  A single IP can be added using the “Add Single IP” button, or a range can be specified using the “Add IP range” button.  Note that “Use Default Ranges” must be unchecked to insert a custom IP range.  After specifying the range, press “Insert” and then “Done” then “Yes” if you want to run the ping script to discover nodes in the specified range.  By checking the “Save as Default” option, any inserted IP Ranges will be added to subsequent “Use Default” insertions.  Additionally, the local machine’s address is always automatically inserted into the IP range list as 127.0.0.1.
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NOTE: For best performance, it is highly recommended that the user only insert a single IP for each Storage and BladeCenter Controllers.  Any problems associated with LCIT discovering multiple addresses for a single node will be addressed in a later release.

4.3. Pinging Inserted IP Ranges

After all desired IP ranges appear in the tree, click the “Ping” button found on the left-hand side to begin the ping process to discover which nodes are responding on the network.
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Upon completion, any responding nodes will appear under the “Pinged” branch and a message showing how many nodes responded will appear above the tree.
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4.4. Collecting Node Information

To begin the collection process, click the “Collect” button found on the left-hand side.  During this process a progress indicator will show how many nodes have been collected from, and the status bar will indicate which node is being collected from as well as an indication as to how long it may take for that particular node.
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Once all nodes have been discovered, their MAC address and Machine Name will appear on the tree next to their IP addresses.
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BMCs and Blades which are in a discovered BladeCenter will automatically appear under their respective owners.  Storage nodes will show their secondary addresses as well.
4.5. Collecting Node Information Again
If the collection process has been run at least once already and is being run again, any existing information files for any nodes which were inserted manually may optionally be kept to save time on future collection processes.  If an Auto-Discover is used, these files will automatically be kept.  If the collection process is run manually, a dialog will appear asking the user which node information files to keep.  This way the user can opt to skip gathering information from any possibly unchanged hardware which would normally take an extra several seconds to a minute per node to collect.
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4.6. Troubleshooting
If a node does not collect information about its MAC and Name, there are a few possibilities:

1. The node has been assigned an IP address but has not yet had the time to generate its information file.  This process can take up to a minute after an IP address has been assigned.  Running the collection process again may discover this information, which can be done by selecting “Re-run” then “Collect” from the “Actions” menu, or by double clicking on the “Collect” button.

2. The manager does not have the correct password key for SSH file copy.

3. The node is not supported by LCIT or is not running the client image.  You may need to restart that machine and make sure it boots from the network. (PXE)

4. The node is no longer responding on the network.

5. Grouping Configuration
The grouping configuration window allows you to group nodes by rack.  To leave all nodes ungrouped, simply click “OK” and save the grouping configuration.
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5.1. Grouping

In order to group nodes, a new group must first be created.  To create a new group, click on “Add New Group” on the right.  Insert the Rack Name, select a Rack Type, and type in a Rack Serial then click “Add”.  This will add the rack to the “Groups” dropdown box in the upper right.  
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Note that any Blades which belong to a discovered BladeCenter will automatically be in the same group as its BladeCenter.

Once a new group has been created, the user is now ready to add nodes to this group.  Select the group from the dropdown box.  Nodes in the left display are capable of being added to a group.  These nodes can be selected by clicking on them.  Shift-click or click and drag, (to select a range), Control-Click (to select an individual node), and selecting the name of the group heading (to select the entire group) can be used as well.  Once the desired nodes have been selected, click “Set to Group” on the right.  
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This process can be repeated for as many groups as are necessary.  Once you are satisfied with the group setup, press “OK” at the bottom of the Grouping Configuration window.
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6. Management
From the discovery view (post-collection), pressing the “Manage” button will bring up the Cluster Manager.  The manager will also appear if LCIT is started with existing configuration files.
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The left-hand side of the window contains a tree with all discovered nodes in their assigned rack groups.  Under the tree are some viewing options, a cluster integrity indicator, and a clock.  To the right of the tree is a long vertical button which allows the user to expand the tree to display more information about each node.

The right-hand side of the window is where cluster, node, and logging information may be found.  When the LCIT manager is first loaded, a cluster summary screen displaying cluster node distribution is shown.  Directly below the information page is a status bar, which shows important message pertaining to actions that have been performed by the user, as well as a message box which contains critical information regarding the status of an individual node.

6.1. Node Tree

The node tree contains all nodes which have been discovered, listed by their MAC (or IP) and grouped by their rack (or machine type).  BladeCenters will contain the nodes underneath them and at which slot they are located.  There is also an icon containing node responsiveness, node type, or whether there is an update available for that node.
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BMC or Alternate Address
The tree can also be viewed by IP Address instead of MAC, as well as Machine Name(Type) instead of Rack.  These can be selected via the “View by:” and “Group by:” menus, respectively.
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Additionally, the tree can show only Active or Inactive (Down) nodes by selecting the appropriate tab above the node tree.

6.2. Node Tree Options Menu

By right clicking on any node in the tree, an options menu will appear with some node, group, and general options.

The “Sort” sub-menu allows for the tree to be resorted ascending or descending based on the node’s identifying value currently on the tree.

The “Node” sub-menu allows for the node which was right clicked on to be identified or for its information log to be exported.  The currently selected node will appear above these options.
The “Group” sub-menu lets the user Export information logs, send Identify, Eject CD ROM, Update, Restart, or Shutdown commands for an entire group (or type, depending on which view is selected).  The currently selected group will appear above these options.
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6.3. Detailed Tree View

To see a more detailed version of the Node Tree, either click the vertical bar to the right of the tree with the plus[+] symbol, or select “Toggle Details” from the “View” menu.
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This view shows MAC Address, IP Address, Serial Number, Machine Type, and Machine Name(Type Group) as columns in the expanded tree.  Items can be interacted with exactly the same as in the collapsed tree.  Double clicking on an item will collapse the tree and open the node’s information page.

To collapse the tree, either click the vertical bar to the right of the window with the minus[-] symbol, or by selecting “Toggle Details” again from the “View” menu.

6.4. Looking at Node Information
Double clicking on a node listed in the node tree will bring up the Node Information tab.
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Information about the selected node is displayed in the right side of the window.  For most node types, several functions can be performed from this page:
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Update:  
This will update the firmware of this node to the version on the CD (only if the CD contains a newer version)
Identify:  
This will turn on the identify light for this particular node and will also cause it to blink at a user specifiable rate
Eject CD:  
Ejects the CD ROM drive tray

Export:

Exports the current node’s information to a log

Open SSH:
Opens a terminal automatically logged in to the node

Reboot:
Reboots the node

Shutdown:
Turn the node off safely
Furthermore, if the node contains a BMC, additional actions will be available:

Export Info:
Exports the information currently contained by the manager about this BMC

Export Events:
Connects to the BMC and exports the entire Sensor Event Log

Clear Events:
Connects to the BMC and clears the entire Sensor Event Log
6.5. Looking at BladeCenter Information

If a BladeCenter is double clicked, the Node Information page will show a report containing which nodes are in which slot, their current response status, as well as which fan, power supply, switch, and management slots are in use.  
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The only action available for BladeCenters is the ability to export their node information log.

6.6. Looking at Storage Node Information

When a Storage node is double clicked, the Node Information page shows information regarding the size and status of each hard drive slot.  Actions include being able to identify one drive at a time or exporting the storage node’s information log.
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6.7. Node Message Box
Located at the very bottom of the right side of the manager window is the message box which contains time-stamped information about a node when it goes offline, come back online, or has an updated information file after coming back online.  Scrolling over each entry will highlight the appropriate node on the tree, clicking the entry will bring up that node’s information page.  These messages will also appear on their respective node’s information page at the very bottom.
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6.8. Help Screen

To bring up a brief help screen from inside the manager, select “Help” from the “About” menu.

6.9. Restarting LCIT

To restart the LCIT Cluster Manager without affecting any settings, select “Restart LCIT” from the “File” menu.  This will not restart the machine, only the main program.  This will also not delete any configuration files, logs, or information.  It will, however, clear any messages inside the message box.
7. Logging Cluster Information

There are several different types of logs, and different ways to go about accessing each of them.  All logs exported within the program will appear in the “Log” tab over the Information page and will automatically be opened upon export.  These logs are sorted by date, then by node (or other log type), and then by time of export.
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Double clicking on any log file, represented by a file icon, will open the log file in the log window to the right of the log tree.

7.1. Summary Log
Summary logs are appended to at every refresh interval (60 seconds by default).  Each entry in the log contains a timestamp, followed by a short report on the current status of the cluster, as well as the status of any nodes which have recently gone offline, or come back online. 
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7.2. Message Box Log
If any messages appear in the Messsage Box, these messages may be exported to a log by selecting the “File” menu, then “Export”, and “Messages”.  
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7.3. Global Log
The global log contains all information accessible to the manager about the cluster, including the distribution of nodes among each rack group, and a listing of each node’s information log.  To export a global log, select “Global” from the “File”, “Export” menu.
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7.4. Details Log

To export a details log, select “Details” from the “File”, “Export” menu.  This log show a condensed detailed information log which contains all nodes sorted by rack group, listed with their MAC addresses, IP addresses, Serial numbers, Machine Type, Firmware versions (also BMC MAC and IP if they exist).
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7.5. Node and BMC Logs
All nodes, regardless of type, can export an information log.  This log may contain more information not shown in the node information page.  This can be done in two ways, either by right clicking on the node in the node tree, then selecting “Node” and then “Export”, or by double clicking on the node, and then clicking the “Export” button at the bottom of the page under the “Actions:” heading.
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If a node contains a BMC, this can only be exported by first double clicking on the node which owns it, and then scrolling to the bottom of the information page under the “BMC Actions:” heading and clicking “Export Info.”  Another BMC log available is a Sensor Event Log, which is accessed by clicking “Export Events.”  To clear a Sensor Event Log, click on the “Clear Events” button.
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To save a log to another location or delete a log, scroll down to the bottom of the desired log after opening it and click on the “Save As…” or “Delete Log” button, respectively.
7.6. Difference Log Viewer and Diff Logs
To view the difference between two logs, whether they are different nodes, or the same node exporting at two different times, you must first open the log difference selector.  This is done by selecting “Log Difference” from the “View” menu.  This will bring up a new pane above the log display itself.
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After opening, the user will be able to select which two nodes to compare.  First, select which file is to be the “Old” file, by first selecting it from the tree, then clicking on the “Select OLD” button.  The “Old” log will now appear with a Cross next to it.  Next, select which file is to be the “New” file, by selecting it from the tree and clicking on the “Select NEW” button.  The “New” log will show a Check next to it.  Click the “Show Diff” button to open the Difference viewer.
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In the Difference Viewer window, the text shown will be that of the “New” file.  Anything highlighted will display what was in the “Old” file when the mouse is positioned over the line.  The difference can also be exported to a human readable text file by clicking on the “Export” button and can be closed by clicking the “Close” button.
8. LCIT Options
A few handy options are available from the “Options” menu, such as user configurable intervals and automated discovery.

8.1. Configurable Preferences

By clicking on “Preference” under the “Options” menu, the user will be able to adjust the name of the management node (currently only shows in the log tab), change the refresh interval time (how often all nodes are pinged), change the maximum number of messages shown in the message box, and change the Identify Cycle parameters (how long the light stays on and how many times it blinks).

8.2. Grouping
Nodes can be grouped into other racks from the manager as well as the discovery wizard.

8.3. Discovery Wizard and Auto Discovery
The discovery wizard can be run at any time by the user after being inside the manager.  This will exit the manager program and re-enter the wizard.  The Auto Discover option allows the wizard to be run without any kind of user interaction using all defaults to discover new nodes.  Any new found nodes will appear as “ungrouped” in the manager and will need to be grouped via the “Grouping” window available from the “Options” menu.
WARNING:  Do NOT close the discovery wizard after you have run the “Ping” option on a new set of IP Address ranges.  After this point you must finish the “Collection” and “Grouping” processes once more before you can safely return to the manager.  Closing the discovery wizard in between this time may cause the LCIT manager to crash and may require complete re-discovery of the cluster.  See the Troubleshooting section if this occurs.
NOTE:  Nodes that were previously grouped will keep their same grouping configurations.

9. Troubleshooting

This section will detail any known problems which may be encountered and possible solutions to these problems.

9.1. Booting Problems
1. The designated “Manager” node is not booting from the CD.
Make sure CD ROM is higher in the boot order than the Hard Disk, and reboot the node.  If failure persists, check the CD for scratches and verify the burn was successful (if burned from an ISO).
2. During boot process, “Failures” appear.
Some Failure messages may appear but will not affect LCIT in any adverse way.  However, if the boot process hangs for more than 5 minutes without any indication of process, it is possible that the CD may have errors.  If failure persists, check the CD for scratches and verify the burn was successful (if burned from an ISO).

9.2. Discovery/First Run Problems
3. IP Addresses are not showing up in the tree.
Make sure you click on the “Insert” button before pressing “Done” from the “Add Custom IP/Range” dialog.

4. Clicking the “Ping” button does not start the pinging process.
Try double clicking on the “Ping” button, and then select “Yes” from the dialog.

5. All nodes that have been turned on are not shown as having responded after running the pinging process.
There are several possibilities, here are a few of them:
-The node may not be set to boot from the network (PXE).  Change the boot order for that node to make sure a network boot comes first.

-The node has not yet fully loaded the network image.  Try pinging again in a few minutes.

-If after several minutes all nodes are still not responding, check network connections.
6. The Collection process is taking too long.
For large clusters, this can be expected to happen.  Each compute node takes about a second to process, storage nodes can take up to ten seconds each, and BladeCenter controllers can take around a minute.  As long as the “dots” in the progress meter are constantly moving, the Collection process should be moving along shortly.  However, if this process is stuck on a single IP for more than a few minutes, there could be further issues (see below).
7. A single node has been on Collection for more than a few minutes.
This could indicate a bad network connection or some other kind of network error.  The best solution may be to clear the IP Range list of this IP and be sure it is not included the next time.  This can be done either by removing all “.list” files from the /opt/lcit directory, or by clearing out all data that has been obtained by entering ./reset_defaults from the /opt/lcit directory. (Be warned, issuing this command will delete all logs, lists, and node information files, resetting LCIT to a factory default state)
8. Some nodes do not show any collected information.
It is possible that the node has just recently booted into the network image and has not yet had time to generate its information file.  This tends to be completed about one minute after a node has acquired an IP address.  Other possibilities include unsupported hardware or a failure to completely load the network image after being assigned an IP address.

9. In the Grouping Configuration dialog, some nodes do not appear in the list.
If a node which is shown in the tree does not show in the grouping list, it is likely considered to be a Blade owned by a discovered BladeCenter.  If this is the case, those Blades will always be placed in the same rack group as its BladeCenter.  Blades which are in a discovered BladeCenter will appear in the tree in a branch just under which one the Blade belongs to.
10. The Discovery Wizard was exited and the Manager failed to load properly.
Each time the Discovery Wizard is run, every step must be finished for the Manager to properly run without errors.  This is especially true the first time LCIT is run without any configuration files, or after a reset to defaults.  If the Manager fails to load and there is no option to re-run the discovery wizard, you may run the discovery wizard separately to repair these configuration files properly by opening an XTerm and typing the following after navigating to the /opt/lcit directory:

# python discovery.py
After successfully running the wizard in this fashion, try running LCIT again.  If there are still failures, there could be problems with the data collection process.  Try to only discover nodes which were previously discovered.

9.3. Cluster Manager Problems

11. The Manager hangs after first being loaded, or during operation.

First, try closing the manager.  If this fails, click on the “Minus” symbol at the very top left of the window and select “Kill” from this menu.  Next, use the LCIT button to bring up the Manager again.  If the program hangs at the loading screen for more than a minute, there may be some problems in the configuration files and discovery may have to be run again.  See the last item in the previous section of troubleshooting for how to fix this.

12. A Node Identify command was issued and failed.
Either the node is currently not able to use the Identify feature (no BMC attached, faulty BMC, or is a BladeCenter controller) or the node is no longer responding on the network.  To test if a node is responding, double click on it from the node free and look to the status bar to see if the ping was successful.
13. A Group (Identify, Eject CD, Update, Restart, or Shutdown) command was issued and some nodes failed.

See the above answer.  Additionally, Restart and Shutdown commands are not available on the local management node (the node running LCIT).  Eject CD, Update, Restart, and Shutdown commands are not available for Storage nodes and BladeCenter controllers.
14. A node which reported a successful Update did not appear to actually update firmware.

If, after restarting from having reported a successful Update, the node did not change firmware revisions as is reported in the node’s information file, the update may have suffered from some other type of error.  To see the output from this, first open an SSH terminal to the node by first double clicking on it, then scrolling to the bottom of its information page and clicking “Open SSH”.  From the new terminal window type update at the command prompt.  Some errors, such as a “syntax error” only mean that there was not a firmware update available for that system.  Other messages may help determine the cause for the inability to update the firmware.
